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REVISION HISTORY

REVISION DESCRIPTION DATE
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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor
for the rights of third parties, which may be effected in any way by the use thereof. Any representations in this document concerning
performance of Evertz products are for informational use only and are not warranties of future performance, either express or implied. The only
warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation
form.

Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no
warranty is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or
order confirmation. Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions. If
you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make
changes in equipment design or specifications.
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1. OVERVIEW

The 7880IP-ASI-IP is a complete hardware based solution to transform ASI to IP, IP to ASI. It can also
regenerate IP from IP input with different settings and add RTP and FEC. As more providers are trying
to deliver contribution and distribution quality video over IP networks, the 7880IP-ASI-IP is capable of
bridging traditional compressed world (ASI) with standard IP networks.

Controlled by the industry leading VistaLINK. PRO, the 7880IP-ASI-IP offers signal providers the
capability to encapsulate MPEG-2 transport stream payload to a unicast or multicast standardized IP
stream. The 7880IP-ASI-IP is also capable of receiving IP stream and re-create ASI stream. For
contribution application, the 7880IP-ASI-IP offers industry standard FEC support for encapsulation or
de-encapsulation.

The 7880IP-ASI-IP occupies one card slot and can be housed in a 1RU frame which will hold up to 3
modules, a 3RU frame which will hold up to 14 modules.

Applications include:

ASI to IP conversion

IP to ASI conversion

IP-IP translation

Unicast/Multicast to Unicast/Multicast translation
UDP or RTP input/output

FEC ProMPEG CoP3 r2 option to IP streams

Features:
o Fully integrated with the Industry leading Evertz VistaLINK:PRO NMS system
2 Independent IP Ports, 1 ASl input, 1 ASI Bypass and 1 ASI output
ASI to IP conversion
IP to ASI conversion
IP to IP translation
FEC encoding and decoding- Pro MPEG forum Code of Practice #3- Release 2<cop3>
Built-in frame controller for control (separate IP port)
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Figure 1-1: 7880IP-ASI-IP Block Diagram
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2. INSTALLATION

2.1. REAR PLATE DESCRIPTION

The 7880IP-ASI-IP comes standard with a companion +3RU rear plate. Figure 2-1 provides an
illustration of the 7880IP-ASI-IP rear plate. For information on mounting the rear plate and inserting the
module into the frame, see section 3 of the 7700FR manual.
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0

Figure 2-1: 7880IP-ASI-IP Rear Plate

2.1.1. Video Connections

ASI IN: This BNC connector is compatible with DVB/ATSC-ASI standards. The maximum
input bandwidth of each input cannot exceed 270 Mb/s.  This ASI Input corresponds
to the Loop Out on the 7880IP-ASI-IP module.

LOOP OUT: This BNC can be used to loop out the ASI input. It is mainly used for troubleshooting
purposes.

ASI OUT: This BNC connector output is compatible with DVB/ATSC-ASI standards. This ASI
Outputs corresponds to the IP Inputs on the 7880IP-ASI-IP module.
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2.1.2. Ethernet Connection

The 7880IP-ASI-IP Series uses 10Base-T (10 Mbps), 100Base-TX (100 Mbps) or Gigabit (1Gbps)
twisted pair Ethernet cabling systems. When connecting for 10Base-T systems, category 3, 4, or 5
UTP cable as well as EIA/TIA — 568 100Q2 STP cable may be used. When connecting for 100Base-TX
systems, category 5 UTP cable is required. The cable must be “straight-through” with an RJ-45
connector at each end. Establish the network connection by plugging one end of the cable into the RJ-
45 receptacle of the card and the other end into a port of the supporting hub.

The straight-through RJ-45 cable can be purchased or can be constructed using the pin-out
information in Table 2-1. A colour coded wiring table is provided in Table 2-1 for the current RJ-45
standards (AT&T 258A or EIA/TIA 258B colour coding shown). Also refer to the notes following the
table for additional wiring guide information.

: : AT&T 258A or 10BaseT
Pin Pin# | Signal EIATTIA S68A EIA/TIA 5688 or 100BaseT
—_— 1 Transmit + White/Green White/Orange X
ngggugg 2 Transmit — Green/White or White Orange/White or Orange X
HEA RN 3 Receive + White/Orange White/Green X
HEH RN 4 N/A Blue/White or Blue Blue/White or Blue Not used (required)
5 N/A White/Blue White/Blue Not used (required)
I:I 6 Receive — | Orange/White or Orange Green/White or Green X
| | 7 N/A White/Brown White/Brown Not used (required)
8 N/A Brown/White or Brown Brown/White or Brown Not used (required)

Table 2-1: Standard RJ-45 Wiring Colour Codes

Note the following cabling information for this wiring guide:

¢ Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals.

¢ Eventhough pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable.

e 10BaseT and 100BaseT use the same pins (a crossover cable made for one will also work with the
other).

e Pairs may be solid colours and not have a stripe.

e Category 5 cable must use Category 5 rated connectors.

The maximum cable run between the router and the supporting hub is 300 ft (90 m). The maximum
combined cable run between any two end points (i.e. router and PC/laptop via network hub) is 675 feet
(205 m).

Devices on the Ethernet network continually monitor the receive data path for activity as a means of
checking that the link is working correctly. When the network is idle, the devices also send a link test
signal to one another to verify link integrity. The rear panel is fitted with two LEDs to monitor the
Ethernet connection.

1000: This Amber LED is ON when a 100Base-TX link is last detected. The LED is OFF when a
10Base-T link is last detected (the LINK LED is ON). Upon power-up the LED is OFF as
the last detected rate is not known and therefore defaults to the 10Base-T state until rate
detection is completed.
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LN/ACT: This dual purpose Green LED indicates that the card has established a valid linkage to its
hub, and whether the module is sending or receiving data. This LED will be ON when the
module has established a good link to its supporting hub. This gives you a good indication

that the segment is wired correctly. The LED will BLINK when the module is sending or
receiving data. The LED will be OFF if there is no valid connection.

2.2. HARDWARE INSTALLATION

To successfully install the 7880IP-ASI-IP, you will require the following items:

1. Unused IP address on the network or a DHCP server
2. Evertz serial cable
3. VLPro Server IP address

Before handling the card it is important to minimize the potential effects of static electricity. It is
therefore recommended that an ESD strap be worn.

Locate on a 7700 chassis two adjacent vacant slots. Unpack the card and separate the rear card from
the main card. Locate on the rear of the rack the two slots and remove the blanking panels. Insert the
rear card into the back of the chassis and secure using the four screws provided.

#¥o BFo Po o o BFo PFo 7o Po

everiz | everilz | everiz | everlz | everiz averiz | everiz foverlz
o o o] ] =] o o] o [o]
9 ) i 6 5 4 3 et g

Figure 2-2: 7700 Chassis Rear Panel

Before inserting the front card, connect the serial cable to the board using the serial cable provided.
Now insert the card into the corresponding front slots ensuring the card lines up with the slot runners on
the bottom and the top of the chassis. Push the card firmly into the slot ensuring that when it mates
with the rear plate that is has been securely pushed into a seated position. This can be confirmed when
the connectivity lights for the Ethernet port are illuminated. Do not connect any cables to the rear card
until the initial configuration has been completed (failure to do this could cause unwanted network
issues).
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Figure 2-3: 7700 Frame Controller

COM1 Properties

Part 5 ettings |
Bitz per second; |1152UD v|
Data bits: |8 v|
Parity: |N-:|ne v|
Stop bits: |2 v|
Flow contral: ~
L (0] 4 ] ’_ Cancel J [ Apply ]

Disconnected Autodetect | Auko detect SCROLL CAPS | mum | Bapture | Print echo

Figure 2-4: COM Port Properties Window

Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal
session and configure the port for the following configuration:

Bits per second 115200
Data Bits 8
Parity None
Stop Bits 2

Flow Control None
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Click OK to apply these settings and press the enter button on your keyboard. The card Main Menu
should appear as shown in Figure 2-5:

& Evertz - HyperTerminal Q@@

Filz Edt View Call Transfer Help

D & 2 DB i

| Main Menu |
| 7880IP-ASI-IP(6.01 build 27) I
) Control Network TCP/IP configuration

} Data Network TCP/IP Configuration

; SHMP configuration

Debug interface

Connected 0:00:31 Auto detect 115200 8-N-2 UM

Figure 2-5: 7880IP-ASI-IP HyperTerminal Main Menu

(1) Control Network Configuration
This sub-menu enables the user to configure the control network settings. The Configuring this sub-
menu allows the user to access the card through the VLPro Client interface.

(2) Data Network Configuration
This sub-menu enables the user to configure the data port network settings. This setup can
alternatively be completed from VLPro once the control network settings have been established.

(3) SNMP Configuration

This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community
strings.

(4) Debug Interface
This menu is for Evertz personnel only. You may be requested to access and execute options within
this menu when seeking technical support from Evertz. Guidance will be given should this be required.

Before is it possible to configure the card via VLPro it is first necessary to configure the initial basic
network settings via the serial cable. Refer to section 2.3.

Revision 1.0 Page 7



7700/7800 MultiFrame Manual '
7880IP-ASI-IP IP/ASI/IP Converter ever Z

2.3. CONFIGURING THE BASIC NETWORK SETTINGS

From the terminal session window select option (1) Control Network Configuration, the Control Network
Configuration menu will be displayed as shown in Figure 2-6.
1. Select option (1) Set IP Address and configure the card IP address, ensuring that the IP
address is not already in use on the network.
2. Select option (2) Set Netmask and configure the correct subnet mask for your network.
3. If required also configure option (3) Set Gateway.
4. Exit the Network Configuration menu using (s) Save and Exit, NOT (x) Exit.

“& Evertz - Hyper Terminal Q@@

File Edt Wiew Call Transfer Help

Oz & & DOE &

| Control Network TCP/IP configuration |
I 7880IP-ASI-IP(0.01 build 27) I

MAC=00:02:C5:10:60:13

I

|

| IP address: 192.168.50.10
| Netmask address: 255.255.255.0
{ Gateway: 192.168.50.1

) Set IP Address
) Set Netmask

) Set Gateway
)
)

Save and Exit
Exit

I%

Connected 0:05:19 Auto detect 115200 8-N-2 UM

Figure 2-6: 7880IP-ASI-IP Network Configuration Sub-Menu

You have now completed the necessary minimum configuration and can connect the cables to the rear
card when ready.
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2.4. CONNECTING TO VLPRO

This chapter assumes that the VLPro server and VLPro client are already configured for your network
and you have basic knowledge of the VLPro interface. It also assumes that the user or network
administrator has already added the appropriate jar file to the server, and both the client and server
applications have been restarted. Please refer to the VistaLINKg manual for instruction on how to load
a jar file. If you are the network administrator refer to section 5.1 for information on updating the VLPro
Server Jar File.

Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” button.
Your card should appear as a newly listed device with the IP address used to configure the card in Step
1 above. It may take up to a minute to appear while the card and switch negotiate network settings (this
can be verified directly on the switch if necessary). Please note that the 7880IP-ASI-IP will identify two
items under the IP address in the navigation tree: IpToAsi and InputTolp. The user will be required to
individually select each item to configure the appropriate function.

It is important to note that the 7880IP-ASI-IP is designed to perform 1 translation at
g a time. ASI-IP, IP-ASI and IP-IP can all be preformed but not simultaneously. Proper
settings on the card must be placed to ensure 1 translation is occurring at a time

As shown in Figure 2-7, the card will list two inputs (numbered one and two).

£ VistaLINK PRO (Standalone) - InputTolp [2]

File  Tree Alarm  Configuration  Audit  Preset  Tools  MWindow  Help

e e A o |vens B B,

D = 192,169 8.67, InputTolp (2] Configuration
ol | e T
o= [retreh & & [ 1.0]| e By e | Bl
Control | Manitar |
L
a1
=3 —ASI Port Control ~Note
AS| Input Made ASI IfInputis IP, please config the source IP controls in 1P to Output cantral.
-Output IP Stream 1 ~Output IP Stream 2
Stream Active Ilnactwe 'I Stream Active Imactive - |
Ethernet Cutput Port 1 Ethernet Output Part 1
Input [as1 - Input [asi -

Source P Address | Source P Address |

Source UDFP Port {0 to 65535) | Source LIDF Port (0 to B5535) |

Destination UDP Port {0 ta 65535) | Destination UDP Port {0 to 65535) |

|
|
|
Destination IP Address | | Destination IP Addregs |
|
|
|
|

RTP Pratacal [on - RTP Pratocal [on -

Tos | T0S |

I | I |

TS Packets Per IP Packet r £ 5 TS Packets Per IP Packet r = -
T8 Packet Size 188 bytes - TS Packet Size 188 bytes -

FEC Mode [or -] FEC Mode [om -

FEC Column r o FEC Calumn r 2 o
FEC Row r & op FEC Row : £ o
FEC Offset (Annex &) |of ~| FEG Offset (Annex A) |of ~|

Figure 2-7: 7880IP-ASI-IP VistaLINKg PRO Hardware Tree Configuration
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Note: If after a couple of minutes the card has still not appeared, try selecting
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used
g in the configuration stage earlier and select OK. The card should now be listed

and will remain greyed out for a moment while VLPro finds the card and
confirms its configuration.

Please consult your network administrator if you continue to have problems connecting the card with
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support.
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3.1.

3.1.1.

3.1.2.

3.1.3.

3.1.4.

3.1.5.

350FR:

SPECIFICATIONS

TECHNICAL DESCRIPTION

Inputs and Outputs

1xASI input per DVB TR 101 891 270Mb/s
1xASI output per DVB TR 101 891 270Mb/s

Min ASI TS input bitrate 100kb/s

Max ASI TS input bitrate 200Mb/s

2xRJ45 10/100/1000 GigE I/O for MPEG over IP
1xRJ45 10/100 control port

Encapsulation Parameters

IP encapsulation for each ASI input:
e MAC 802.3>IPV4>RTP>UDP>MPEG (RTP can be turned on and off)
e Select 1to 7 MPEG packets per IP frame
Optional FEC encoding (Pro MPEG forum code of practice #3- release 2<cop3>) with L&D
following the below mentioned range:
L*D <100
1<L<20
4<D<20
IP address (IP, Subnet mask, Gateway) for the source
IP address for the destination (Unicast and Multicast)
Selection of the source port and destination port
Set Local MAC address of the equipment

De-Encapsulation Parameters

Join Multicast by providing correct messaging using IGMP V2/V3 (SSM Support)
Selection of the UDP Ports

Monitored Parameters

Total Bitrate

Null Packet Bitrate
TS sync_loss
Continuity count error
PID List

Physical (number of slots)
1

7700FR-C: 1
7800FR: 1
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4. CARD CONFIGURATION

Right click the IP address and sub-modules of the 7880IP-ASI-IP to access and configure their
parameters. Select “View Configuration” from one of the modules available (Main, IpToAsi and
InputTolp). The configuration page will open enabling the user to toggle the configuration tabs in order
to configure the parameters of the 7880IP-ASI-IP. Sections 4.1 to 4.3 provide an explanation of the
features and functions of the 7880IP-ASI-IP card.

4.1. CONTROL TAB

The control tab is divided into three sub-sections, which include: ASI Port Control, Output IP Stream
1 and QOutput IP Stream 2.

|5, 192168867, InputTolp [2]: Configuratio aE E
e @ @[] By B | By

Caontrol ‘\ Monitor\

&SI Port Control ~Note
ASI Input Mode ASI If Input is IP, please config the source IP controls in IP to Output control.

~Output IP Stream 1 ~Output IP Stream 2
Stream Active | nactive - Stream Active (Inactive ~|
Ethernet Qutput Port 1 Ethernet Output Part 1
Input (a1 - Input = ~|
Source IP Address | | Source [P Address | |
Source UDP Part (0 to B5535) | | Saurce UDP Part (0 to B5535) | |
Destination IP Address | | Destination IP Address | |
Destination UDP Port (0 to B5535) | | Destination UDP Part (0 o 65535) | |
RTP Protocal on - RTP Pratocol on ~|
TOS | | Tog | |
n | m | |
TS Packets Per IP Packet I i 7 TS Packets Per IP Packet I 1 7
TS Packet Size [1 88 ytes v] TG Packet Size [1 B8 bytes v]
FEC Mode lor - FEG Mode o ~|
FEC Column L 15 a0 FEC Calumn I ikt a0
FEC Raw r £ on FEC Row . & o
FEG Oifset (Annex &) |of ~| FEG Offset (Annex A) o ~|

Figure 4-1: InputTolP Control Tab

41.1. ASI Port Control Section

The ASI Port Control allows the user to enable or disable the physical ASI input on the card.
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4.1.2. Output IP Stream 1 & 2 Sections

Please note that the controls for Output IP Stream 1 and 2 are identical, therefore for the sake of
simplicity only Output IP Stream 1 will be discussed in this manual.

Stream Active: This option allows the user to quickly enable or disable the outgoing Ethernet
stream by selecting either Active or Inactive.

Ethernet Output Port: This field shows which physical data port is being used for streaming
data.

Input: This field allows the user to select the source of the stream. The user will select either
ASl or IP.

Sources IP Address: This field enables the user to enter the source IP address. This address
can be the physical IP address of your data port, or any other address that you may want to be
encapsulated within the IP packets.

Sources UDP Port (0 to 65535): This field enables the user to enter the source port number for
the IP address entered above.

Destination IP Address: This field enables the user to enter the unicast or a multicast IP
address. Multicast addresses should be in the range of 224.0.0.0 through 239.255.255.255.

Destination UDP Port (0 to 65535): This field enables the user to enter the destination port
number for the IP address entered above.

RTP Protocol: Use this drop down box to enable (On) or disable (Off) the use of the RTP. The
use of RTP is recommended as it provides services such as time stamping, sequence
numbering and delivery monitoring, which can be beneficial for real-time delivery systems. Also
this protocol must be enabled if the user wishes to use the FEC (Forward Error Correction)
mode.

TOS: This field enables the user to enter the ToS (Type of Service) value, if your network does
not support ToS, use zero as default.

TTL: This field enables the user to enter the TTL (Time to Live) value. Using the multicast IP
protocol, the TTL value indicates the scope or range in which a packet may be forwarded. By
convention:

0 is restricted to the same host

1 is restricted to the same subnet

32 is restricted to the same site

64 is restricted to the same region
128 is restricted to the same continent
255 is unrestricted

TS Packet Per Frame: This field enables the user to enter the number of MPEG packets to be
encapsulated per IP packet. The range of MPEG packets per IP packet is from 1 to 7. Long-
length packets are undesirable due to the excessive impact from losing each IP packet. Short
packets cause a high overhead so a value chosen will be a compromise between these two
factors.
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e TS Packets Size: This field enables the user to select the size of the TS packet. The size
options include Auto, 204 bytes or 188 bytes.

e FEC (Forward Error Correction) Mode: This field enables the user to enter the FEC mode to
be used. It will be either FEC 1D (1 Dimensional) or FEC 2D (2 Dimensional).

e FEC Column: This field enables the user to enter the number of packets per column to be
associated with an FEC packet.

e FEC Row: This field enables the user to enter the number of packets per row to be associated
with an FEC packet.

e FEC Offset (Annex A): Use this drop down menu to enable the use of a non-block aligned FEC
arrangement, which is an alternative method of generating the FEC packets.  For more
information on the FEC offset refer to the Pro-MPEG Code of Practice #3 release 2, Annex A.

4.2. MONITOR TAB

The Monitor page displays the status of the Ethernet Data ports and the ASI input ports. The Output IP
Stream Monitor section displays the port's mode of operation in the Status field and the Total Bit
rate that is being output.

The ASI Input Monitor section displays the status of the ASI inputs. The status will not change unless
a valid ASI feed is detected (you may be required to refresh the status or select auto-refresh to view the
change). Using the auto refresh button can aid troubleshooting of connectivity issues, however, it will
prevent any configuration changes. The ASI monitoring fields can be reset at any time by clicking on
the “Clear ASI 1 Stats” button.

There are no user configurable items on this page. This page is for information purposes only.
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e |

B 192168 867, InputTalp [2]: Configuratio
[ratresn 0 [ 1.0 |soes By Bz | B

Contral " r-nonitor\l

rOutput IP Stream 1 rOutput IP Stream 2
Stream Type Stream Type
Sent Ethernet Bandwidth 0.050 Mhits/s Sent Ethernet Bandwidth 0.050 Mhits/s
Sent P Packets 50 Sent P Packets 50
Sent TS Packets 50 Sent TS Packets 50
Clear Stream 1 Stats Clear Stream 2 Stats

rASI Input Monitor
AS| Input

AS| FPort Status

ASI TS Bitrate 0.050 Mhits!s
AS| Useful Bitrate 0.050 Mbitsfs
ASIMull Packet Bitrate 0.050 Mhits!s
AS| Syne Lost a0

ASI Continuity Caunt Errars a0

ASl Input Packet Size 188 hytes

Clear AS| Stats

Figure 4-2: InputTolP Monitor Tab

4.2.1. Output IP Stream 1 & 2 Sections

Please note that the field for Output IP Stream 1 and 2 are identical, therefore for the sake of simplicity
only Output IP Stream 1 will be discussed in this manual.

e Stream Type: Depending on the destination IP addresses the Stream Type will be a Multicast or
Unicast

e Sent Ethernet Bandwidth: This field identifies the current bitrate of the Output IP Stream 1.

e Sent IP Packets: This field identifies the current total number of IP Packets sent.

e Sent TS Packets: This field identifies the current total number of TS Packets sent.

e Clear Stream Stats: The network statistic can be reset at any time by selecting the “Clear Stream

Stats” button. To apply the new setting, click the Apply button and the statistics will be reset and
begin counting from zero again.
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4.2.2. ASI Input Monitor Section

e ASI Input: This field displays the standard of the ASI signal.

¢ ASI Port Status: This field displays whether the status of the ASI signal is Active or Inactive.

o ASI TS Bitrate: This field displays the overall bit rate of the incoming ASI signal.

e ASI Useful Bitrate: This field displays the payload total bit rate.

o ASI Null Packet Bitrate: This field displays the null packets bit rate

e ASI Sync Lost: This counter increments every time the sync bite is not detected. The actual
synchronization of the TS depends on the number of correct sync bytes necessary for the device to
synchronize; two or more consecutive corrupted sync bytes indicate sync loss.

¢ ASI Continuity Count Errors: A continuity counter error is indicated if the value of the continuity
counter field within a payload packet is not incremented by one, and the packet is not a valid
duplicate or discontinuity packet.

e ASI Input Packet Size: This field displays the input packet size: MPEG2 TS Packet 188/204 byte

e Clear ASI Stats: The ASI monitoring fields can be reset at any time by selecting the “Clear ASI

Stats” button. To apply the new setting, click the Apply button and the statistics will be reset and
begin counting from zero again.
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43. IPTOOUTPUT TAB

The IP to Output tab enables to configure and view the parameters of the IP inputs and ASI Outputs.
This tab controls the IP input to be used for ASI output or IP retransmission.

& 192.168.8.67, InToAsi [1]: Configuration arE E

|errsn 2 [1.0][ 50 By Bz | B
IP to Output |

r&Sl Port Control P Input Manitor
AS| Output Enable [Disabled v] Strearm Type
AS| Qutput Select [Stream 1 '] Received Ethernet Bandwidth a0 khps
1P Input Control Received IP Packets &0
Strearn Active [Inactive '] Received TS Packets 50
Multicast IP Address | | UDP/RTP Protocol Unknowen
Cestination LUDP Paort Mumber (0 to 65535) | | TS Packets per IP Packet 7
Ethernet Input Fort [1 'l TE Packet Size
Stream Delay (ms) | | FEC Mode off
-AS! Output Monitor ASC Gl 2
AZ| Port Status Inactive FEC Row 20
Serial Qutput Cperating Mode ASI Mumber of Carrected FEC Frames a0
ASITS Bitrate 0.050 Mhitsis Number of Uncorrected FEC Frames 50
Serial Cutput Port Yideo Standard Unknown Clear Stream Stats
| crearasistats |

Figure 4-3: IP to Output Tab

4.3.1. ASI Port Control

e ASI Output Enable: This control enables the user to enable or disable ASI Output.

e ASI Output Select: This control enables the user to select the source of the ASI Output. (Currently
1 Stream source)

4.3.2. IP Input Control Section
e Stream Active: Use this drop box to disable or enable the incoming IP stream
e Multicast IP address (0.0.0.0 for Unicast): Enter the destination IP address (This will be the

multicast address you want the 7880IP-ASI-IP to capture). Ensure that you enter the correct IP
address. A multicast address should be in the range of 224.0.0.0 through 239.255.255.255.

e Destination UDP Port Number (0 to 65535): This field enables the user to enter the destination
port number for the IP address entered above.

e Ethernet Input Port: Use this drop box to specify which physical data port is to be used to capture
the IP stream.

Revision 1.0 Page 17



7700/7800 MultiFrame Manual '
7880IP-ASI-IP IP/ASI/IP Converter ever ZO
e Stream Delay (ms): This field enables the user to set the size of the stream delay. A larger stream
delay value will correspond to a larger buffer size. The total delay through the card is equal to the

decapsulation processing time, plus FEC processing time, plus the stream delay time. The
recommended stream delay value is 60 ms.

4.3.3. ASI Output Monitor
e ASI Port Status: This field displays the status of the ASI signal whether it is Active or Inactive.

¢ Serial Output Operating Mode: This field displays the operating mode of the serial output. It will
display ASI or IP.

e ASI TS Bitrate: This field displays the overall bit rate of the incoming ASI signal.
e Serial Output Port Video Standard: This field displays the video standard of the serial output port.
e Clear ASI Stats: The ASI monitoring fields can be reset at any time by selecting the “Clear ASI

Stats” button. To apply the new setting, click the Apply button and the statistics will be reset and
begin counting from zero again.

4.3.4. IP Input Monitor
e Stream Type: This field will display whether the card is set to unicast or multicast.
e Received Ethernet Bandwidth: This field will display the current bitrate of the input IP stream
e Received IP Packets: This field will display the current total number of received IP packets.
e Received TS Packets: This field will display the current total number of received TS packets.

¢ UDP/RTP Protocol: This field will display the protocol setting depending on the incoming packets.
The options will be either UDP or RTP.

o TS Packet Per IP Packet: This field will display the number of TS packets within each IP packet.

e TS Packet Size: This field will display the TS packet size. The values will be either 188 bytes or
204 bytes.

e FEC Mode: This field will display the FEC mode. The FEC packet mode will display either Off, FEC
2D or FEC 1D.

e FEC Column: This field displays the number of packets per column to be associated with an FEC
packet.

e FEC Row: This field displays the number of packets per row to be associated with an FEC packet.
e Number of Corrected FEC Frames: This field will display the number of corrected frames by FEC.

e Number of Uncorrected FEC Frames: This field will display the number of uncorrected frames by
FEC.

Page 18 Revision 1.0



everl_z 7700/7800 MultiFrame Manual

7880IP-ASI-IP IP/ASI/IP Converter

e Clear Stream Stats: The network statistic can be reset at any time by selecting the “Clear Stream

Stats” button. To apply the new setting, click the Apply button and the statistics will be reset and
begin counting from zero again.
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5. TROUBLESHOOTING

5.1. UPDATING VLPRO SERVER JAR FILE

Evertz products are constantly evolving and new features are often added. It is therefore important to
update the JAR files in use to provide access to all the latest features or enhancements. It will also be
necessary to add JAR files for new products. If your new product has not appeared even after waiting a

few minutes for the Ethernet switch negotiation to complete, then it is possible that your JAR file may
be old or missing.

To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.

1 VistalINK PRO Server =5
File  Tools el
SOt Actlvgte License... g Clients | &8 NCP ‘\m Third Party \".

Flohhar Apply Update... 4 Product... P

Database: About... Databage... Cescription "

DEADMmIN: (] T 2007-06-05 Lagger Running State setto log events

: 2230054 2007-08-05 Completed retrieval of alarm server settings
E-mail System: . ] i :
22:30:54  2007-06-08 Logger Running State setto log events
MCP System 00 |l22:30:64  2007-05-05 Retrieving alarm server systemn settings
WP Ack Systerm: (9 ||22:30:37  2007-06-05 Starting Database

s oy (2230037 2007-06-05  Alarm Server startup initiated

AutoResponse Systemn: )
MIE Parsing Support: (5]

License
Expires on 15-06-2007

1 General Clients
2 Plus Clients
-eh Clients

- Flus ¥Weh Clients

System Statistics

Clear

Figure 5-1: VistaLINKg PRO Server

A window will appear, as shown in Figure 5-2, navigate to the location of the new JAR file and double

click to select the file. The window will automatically close and the update will be applied in the
background.
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File  Tools Help

Status | 59“’9”—09\ ﬁ.' .C.\ientS\ﬁ:i HCP \m Third Paﬂy\

Metwork: P
Diatabase: 1 Open
DEAdmin: Lookln: [E3 WLPRO - BRE
E-rmail System: =

HCP Systern: C3 jar Drivers

MWP Ack Systern
Logaing Systemn:
AutoResponse Systern:
MIE Parsing Support:

License
Expires on 15-06-2007

1 General Clignts File Marne: ‘ |
2 Plus Clients
- \Meb Clients
- Plus Weh Clients

Files of Type: ‘ProductUpgradeJar(s) ']

Clear

Figure 5-2: VistaLINKg PRO — Applying JAR Updates

You will be prompted to restart the server to enable the change to take effect. Apply as many JAR
updates as required before restarting the server.

Please Restart Your Alarm Server, g|

. The Alarm Server must be restarted before the product upgrades will be applied.
l Flease restart the Alarm Server nowe. [Fthere are any redundant seniers running,
each one must be started up as the master server before the product upgrades

il e applied to them.

NOTE: You may confirm that all updates have been successfully applied by
,Ef selecting from the menu Tools>View>Show/Hide Product update log.

From the menu, shutdown the server by selecting File>Shutdown Server. Now re-open the server, it is
normal for the start-up to take marginally longer while each individual update is being applied. Once
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay
while the update is applied. A prompt will appear confirming that the updates have been applied.
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